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6:  GRADEBOOK BASICS 
 

WELCOME TO THE MOODLE GRADEBOOK BASICS TUTORIAL! 

In this tutorial, you will learn: 

• How to configure the online gradebook in a simple fashion 
• How to manually add graded items to the gradebook 

If you have not used one of CareerTech’s “How to Moodle” tutorials before, view the instructions for 
using it as a self-paced tutorial or as a resource for classroom instruction. 

Before reading this tutorial, you should have a Moodle course or practice site and be familiar with: 

• Setting up a course in Moodle 
• Adding quizzes and activities to your course 

NOTE: This tutorial was purposely kept simple. When learning to use any technology, a new user can 
easily feel overwhelmed. A Moodle LMS comes loaded with advanced functionality, but instructors must 
first feel confident using the basic features. After establishing a knowledge base, instructors can easily 
search to find information about a specific change to implement. 

 

MENU OF TUTORIAL TOPICS 

 
• Introduction 
• Planning to Use the Gradebook 
• Creating a Grading Plan 
• Choosing an Aggregation Method 
• Opening the Moodle Gradebook and Selecting Main Course Aggregation 
• Creating Categories in the Gradebook 
• Creating Course Activities  
• Creating Manually Graded Items 
• Assigning weights for items in weighted aggregation methods 
• Summary and Resources 
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INTRODUCTION 

 

Setting up the online gradebook from the start can prevent avoidable problems from occurring while the 
course is underway. 

As you work with the Moodle gradebook keep in mind these commonly used terms: 

• Grader report—This is generally referred to as the gradebook. The first tab shows all the 
students enrolled in your course, all the graded items, and the grades. 

• Grade items—A grade item is each gradable course activity, such as a quiz or an assignment. 
You can modify the settings of each item to determine how it is graded. 

• Grades—Grades are scores earned by students on an activity or graded item. You can modify 
grade settings to change how grades are displayed to users, including locking and hiding 
functions. 

• Grade categories—A grade category groups grade items together. You can set the aggregation 
and the way graded items display.  

 

PLANNING TO USE THE GRADEBOOK 

 

Before you open the gradebook in Moodle, plan what you’re going to do. Focus on key strategies for 
success when working with the Moodle gradebook, including: 

• Organization—Organize the graded items in your course to make it easier to manage graded 
activities and calculate final grades for your students. This means creating grade categories in 
your gradebook. For example, if you place all quizzes in a category called “Quiz,” you can do 
what you want to the total quiz score without affecting grades for other activities. You cannot 
do that without using categories. 
 

• Grade calculation—In Moodle, “aggregation” refers to grade calculation. There are many ways 
to assign and aggregate grades. Some grades setting are determined at the activity level, some 
at the category level, and some at the course level. You also can decide whether to give extra 
credit, to grade using peer evaluation, and to use letter grades or scales, either for a particular 
category or for the course total. 
 

• Appearance—You can set up your course to let students see their grades as they complete 
activities, or you can decide to hide grades until a certain point. You can also set up grade 
reports the way you want to see them. 
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The following outlines a process to implement these strategies for success: 

 Before the course starts: 
1. Outline a grading plan of your course activities and point values or scales based on your 

syllabus 
2. Execute the grading plan in the Moodle gradebook: 

a) Choose course aggregation 
b) Create categories 
 Assign aggregation methods for individual categories 

c) Create course activities 
d) Create manual grade items 

 During the course: 
o Assign grades 
o Review grades 
o Confirm or adjust grades 
o Show/hide view of grades 

 At the end of course: 
o Review grades 
o Confirm or adjust grades 
o Report final grades 
o Backup and archive a copy of your course grades and keep the file in a safe place 
o Unenroll students, so that you can start fresh for the next class 

 

CREATING A GRADING PLAN 

 

Use your syllabus to outline a grading plan of your course activities and point values or scales. Create an 
outline similar to the following example, which provides the information you need to define settings in 
Moodle. 

Grading Plan 
Activity Points Category 

Friday Quizzes 75 Quizzes 
Mid-term Exam 50 Exams 
Construction Project 75 Projects 
Barn Design Workshop 35 Projects 
Electrical Plan 15 Projects 
Research Project 50 Projects 
Forum 75 Participation 
Attendance 75 Participation 
Final Exam 100 Exams 
TOTAL 550 90-100% = A 

80-89% = B 
70-79% = C 
60-69% = D 
0-59% = F 



 Gradebook Basics 

 

©2018—Oklahoma Department of Career and Technology Education Gradebook Basics—4 

CHOOSING AN AGGREGATION METHOD 

 

The term “aggregation method” refers to how Moodle calculates student grades. Each category in your 
Moodle gradebook has an aggregation method setting. Best practices include choosing only one or two 
aggregation method and sticking with them throughout your course. Set up a grading system that aligns 
with your syllabus and overall goals for the course. 

This tutorial describes Moodle’s three most commonly used aggregation methods—Simple Weighted 
Mean of Grades, Weighted Mean of Grades, and Natural aggregation.  

Simple Weighted Mean of Grades 

• Why use Simple Weighted Mean of Grades?—Use this choice when you want grades to have 
weighted input to the category total based on the amount of points the activity is worth. This 
works best for the instructor who sets all activities to be worth different point values, but wants 
an “average” for the category or course total. The Simple Weighted Mean of Grades aggregation 
method automatically gives grades with a higher maximum total a higher weight. 
 

• How to use Simple Weighted Mean of Grades—Use this method when the graded items worth 
the most points are the most important to the overall grade. If you want control over the 
weighting of each activity or graded item, consider using the Weighted Mean of Grades 
aggregation instead. 
 

• How grades are calculated—For each activity, the points earned are divided by the points 
possible, and then multiplied by the activity’s maximum grade minus the minimum grade. The 
totals for the activities are added together and divided by the total number of points possible at 
that given time. 

If the minimum points possible is zero, the result will be the same as Natural aggregation. 
However, the Natural aggreagation method has limitations that will make Simple Weighted 
Mean the better choice in most cases. 

• Example of Simple Weighted Mean of Grades— 

This example uses three activities. 

o Activity A is worth 0-10 points 
o Activity B is worth 0-100 points 
o Activity C is worth 0-50 points 

Using the Simple Weighted Mean of Grades, the grade a student earns on Activity B will carry 
the most weight because it has the highest maximum points possible. 
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For a specific student who earns these grades for the three activities: 

o Activity A—10 points earned out of 10 possible 
o Activity B—90 points earned out of 100 possible 
o Activity C—44 points earned out of 50 possible 

This student’s grade will be calculated as: 

[ (10/10 x 10) + (90/100 x 100) + (44/50 x 50) ] / 160 = 90% 
 

NOTE: Do not change the course and category totals in the Moodle gradebook. Leave them at 
100.00. 

Weighted Mean of Grades 

• Why use Weighted Mean of Grades?—Use this method when creating multiple categories or 
activities that need to have different weights in relation to the total grade. This method allows 
you to customize the weight given to each category and/or activity, regardless of the point value 
given to the activity. 
 

• How to use Weighted Mean of Grades—If you want your course to have categories with 
specific weights, set your main course aggregation to Weighted Mean of Grades. The categories 
within your gradebook will have a weight box where you type in the weight for each category. 
Make sure your weights are distributed appropriately, and equal up to 100% total. Weighted 
Mean of Grades can be used for both overall course aggregation and individual categories. Keep 
the course total and each category total as 100.00. 
 

• How grades are calculated—For each activity, the points earned are divided by the points 
possible, and then multiplied by the desired weight of the activity, expressed as a percentage. 
The resulting values for each activity are added together to find the final grade. 
 

• Example of Weighted Mean of Grades— 

This example uses four categories with multiple assignments within each category. In this 
example, the instructor would like class assignments to carry the most weight, so assigns the 
following weights to each category. 

o Category 1 Assignments = 50% 
o Category 2 Attendance = 10% 
o Category 3 Unit Exams = 30% 
o Category 4 Semester Exam = 10% 
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If the student receives the following overall grades within each category, his or her grade will be 
calculated as:  

o Category 1 Assignments = 100% 
o Category 2 Attendance = 100% 
o Category 3 Unit Exams = 50% 
o Category 4 Semester Exam = 50% 

(100/100 x 50%) + (100/100 x 10%) + (50/100 x 30%) + (50/100 x 10%) = 80% 

Since the assignment category carried the most weight, the student still has a passing grade 
even though the student did not perform well on the unit exams and the semester test. 

If all the grade items within a category are of equal weight, you can use Simple Weighted Mean 
of Grades within each category with the overall course aggregation as Weighted Mean of 
Grades. It is not recommended to use more than two aggregations. Keep the gradebook 
simple. 

The following outlines an example of a gradebook: 

Course Aggregation: Weighted Mean of Grades 

 Category 1:  Simple Weighted Mean of Grades Weight:  50 % 

Category total: 100.00  

Grade item 1: 100 points 
  Grade item 2: 50 points 
  Grade item 3: 25 points 
  Grade item 4: 10 points 
 

Category 2:  Simple Weighted Mean of Grades Weight: 20% 

Category total: 100.00 

Grade item 1: 20 points 
  Grade item 2: 50 points 
  Grade item 3: 25 points 
 

Category 3: Simple Weighted Mean of Grades Weight: 30% 

Category total: 100.00 

  Grade item 1: 100 points 
  Grade item 2: 50 points 
  Grade item 3: 25 points 
  Grade item 4: 10 points 

Notice the weights entered equal 100%.  
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NOTE: Since the main course aggregation is Weighted Means of Grades, if a student does not 
perform well on an activity with the greatest weight, the resulting final grade will be lower than 
a course with the main aggregation set as Simple Weighted Mean of Grades. 

Natural Aggregation 

• Why use Natural aggregation?—Teachers who give an arbitrary number of points to all 
assignments and want a simple total of points as the final grade should use this method. 
 

• How to use Natural aggregation—There is no extra step required for this aggregation method, 
but there are some limitations. Some gradebook functionalities do not work when you use the 
Natural aggregation method: 

o Scales will not be used in calculating totals. You can use them in your course, but they will 
not be included properly in calculating a course or category total. 

o The “Aggregate only non-empty grades” feature will not work. This means if Activities A and 
B are completed, but Activity C is still underway and does not have a grade, the calculation 
that shows will be erroneously low. 

• How grades are calculated—Natural aggregation adds together all point values earned and then 
divides by the total possible points. The total is shown as a point value, or can be adjusted to 
display as a percentage. 
 

• Example of Natural aggregation— 

Again using the same three activities: 

o Activity A is worth 0-100 points 
o Activity B is worth 0-50 points 
o Activity C is worth 0-50 points 

And the same student who earns these grades for the three activities: 

o Activity A—95 points earned out of 100 possible 
o Activity B—50 points earned out of 50 possible 
o Activity C—45 points earned out of 50 possible 

This student’s grade will be calculated as: 

(95 + 50 + 45) / 200 = 95% 
 
 

  



 Gradebook Basics 

 

©2018—Oklahoma Department of Career and Technology Education Gradebook Basics—8 

OPENING THE MOODLE GRADEBOOK AND SELECTING MAIN COURSE AGGREGATION 

 

Now that you have a plan, use the following steps to access the gradebook in Moodle and set your main 
course aggregation: 

Step Action Notes 

1.  From the course page, click on the Course 
Management button in the upper left. 
Under the User Links heading, click Grades 
overview. 

This will open the Grader report. By default, 
the display shows the View tab. Other displays 
and functionality are available by clicking other 
tabs and settings on the page. 

2.  To set your main course aggregation, click 
on the Setup tab.  

The Gradebook setup page will display. 

3.  In the Actions column next to your course 
name, click the Edit dropdown menu, and 
then click Edit settings. 

 

Click edit settings. Next to your course name, 
select the desired course aggregation from the 
dropdown menu. 

On the Gradebook setup page, leave the 
Course total at 100.00. If you choose Weighted 
Means, you will add weights once you create 
your grade items or categories. 

 

CREATING CATEGORIES IN THE GRADEBOOK 

 

Categories can be used to organize the gradebook in many different ways and for many different 
purposes. In some instances, categories are required for configuring the gradebook for specific uses. 
Common ways to divide the gradebook into categories include: 

• Activity type—This is almost always the categorization type used with a weighted gradebook. It 
allows you to group all like activity types together in one category with one aggregation method. 
For example, you could create a quiz category for all of your quizzes. 

• Time—You may want to group your class activities together according to the term in which they 
occur. For example, you could create two categories named Semester 1 and Semester 2. 

• Grade status—This method groups activities by those that have been graded and those that are 
not yet graded. This division helps students see an accurate grade at any given time, although it 
is not the only way to achieve this. 
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When starting out with the gradebook in a course, the only category will be the course category, which 
is considered the parent category of any new categories you create. You could potentially add sub-
categories, where you would need to assign one of your new categories as a parent. However, this is 
only recommended for those who are experienced with the gradebook and how it functions. 

Considerations: 

When it comes to aggregations and using the gradebook, consider the following: 

• Start simple and slowly add in new functionality as you learn. 
• Choose an aggregation that you understand. If you don’t understand it (and can’t explain it), 

then your students won’t either. 
• If you want to use extra credit, choose the aggregation methods that work best with it (Simple 

Weighted Mean of Grades and Natural aggregation). 
• When you want to try something new, research online using resources such as Moodle Docs or 

YouTube. 
 
To add a category to the gradebook, use the following steps: 

Step Action Notes 

1.  From the course page, click on the Course 
Management button. Under User Links, 
click Grades overview. 

 

This will open the Grader report. By default, the 
display shows the View tab. Other displays and 
functionality are available by clicking other tabs 
and settings on the page. 

2.  Click on the Setup tab. At the bottom of the 
page, click the Add category button. 

The page includes two sections—Grade 
category and Category total. Click the Show 
more link, which reveals additional settings. 

This will open a page with settings to add a new 
category to the gradebook. This page allows you 
to add a category using primarily default settings, 
or to customize the settings in more detail. 

3.  Section: Grade category  
Field: Category name 

Enter a name for your category. 

Give the category the name you want it to display, 
such as “Quizzes,” “Semester 1,” “Unit 1,” etc. 

4.  Section: Grade category 
Field: Aggregation 

Select the desired aggregation method for 
this category total. 

This field determines how grades in a category are 
combined to calculate the total for the category. If 
you intend to have weights for the categories, 
select Weighted Mean. If you want an average of 
the grade items in the category, select Simple 
Weighted Mean. 
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Step Action Notes 

5.  Section: Grade category 
Field: Exclude empty grades. 

Check the box to enable this functionality. 

If this setting is enabled, Moodle will not use 
grades that don’t have a value yet when 
calculating the category aggregation. (Natural 
aggregation is not an option.) 

If not enabled, Moodle will count the empty value 
as a minimal grade, for example 0 for an 
assignment graded between 0 and 100. 

6.  Section: Grade category  
Field: Include outcomes in aggregation 

Check the box to enable this functionality. 
(Please note this is atypical.) 

Outcomes are an alternate method of grading in 
Moodle that use specific descriptions of 
knowledge or skills a student has demonstrated at 
the completion of an activity or course.  

If you are using outcomes in your course, you may 
want to include them in your aggregation. If you 
choose to enable this setting, be aware that it 
may have an unintended, or undesired, effect on 
the category or course total. 

7.  Section: Grade category  
Field: Drop the lowest 

Type in the number of the lowest grades to 
be dropped. 

This setting enables a specified number of the 
lowest grades to be excluded from the 
aggregation. For example, if the category includes 
multiple assignments, you can decide that all 
grades should be included in the calculation 
(select 0, the default selection), or you may want 
to drop the lowest grade, the lowest two grades, 
or more. 
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Step Action Notes 

8.  Section: Category total 
Field: Grade type 

Select the desired grade type for this 
category from the dropdown list. 

(Choosing Scale in the Grade type 
dropdown menu enables the Scale 
dropdown menu below, which includes five 
choices.) 

There are four options: 

• None—No grading 
• Value—A numerical value with a maximum 

and minimum (typically used) 
• Scale—An item in a list. If you choose scale, 

you will then be able to choose the scale you 
want aligned to this category. 

• Text—Feedback only 

Only Value and Scale grade types may be 
aggregated. Certain fields in this section will be 
deactivated or activated, depending on the 
selection for the Grade type option. 

Remember, this selection is the grade type for the 
category. The grade type for any activity-based 
grade items within the category is set on the 
activity settings page.  

9.  Section: Category total 
Field: Maximum grade 

Enter a value for the maximum grade value 
for this category. 

Changes are not recommended. This setting 
determines the maximum grade when using the 
value grade type. The default setting is 100 and, in 
most situations, there is no real reason to change. 

10.  Section: Category total 
Field: Minimum grade 

Enter a value for the minimum grade value 
for this category. 

Changes are not recommended. This setting 
determines the minimum grade when using the 
value grade type. 

11.  Section: Category Total 
Field: Grade to pass 

Enter a value that must be achieved for a 
passing grade in this category. 

This setting determines the minimum grade 
required to pass. The value is used in activity and 
course completion and in the gradebook, where 
pass grades are highlighted in green and fail 
grades in red. 

12.  Section: Category total 
Field: Grade display type 

Select the desired display type for this 
category from the dropdown list. 

This setting determines how grades are displayed 
in the grader and user reports. There are multiple 
options available. 

• Real grades are numerical  
• Percentages show percentage 
• Letter grades use letters or words to 

represent a range  
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Step Action Notes 

13.  Section: Category total 
Field: Overall decimal points 

Select the desired display of decimal points 
for this category from the dropdown list. 

This setting determines the number of decimal 
points to display for each grade. It has no effect 
on grade calculations, which are made with an 
accuracy of five decimal places. 

14.  Section: Category total 
Field: Hidden, Hidden until 

Check the box to enable this functionality. 
You may also enter a date when the 
category total will be displayed. 

If Hidden is checked, grades are hidden from 
students.  

A “Hidden until” date may be set, if desired, to 
release grades after grading is completed. You 
must check the Enable box associated with the 
date fields to activate the date fields. 

15.  Section: Category total 
Field: Lock after 

Check the box to enable this functionality. 
You may also enter a date when the 
category total can be unlocked. 

If Locked is checked, grades will no longer 
automatically update based on the related 
activity. Locking prevents the ability to change 
grades, and it disables quick grading and quick 
feedback in the Grader report. 

16.  Section: Category total 
Field: Weight 

This determines the relative value of multiple 
grade items in a category or course. 

17.  Click the Save changes button at the 
bottom of the page. 

The Setup tab of the Grader report displays with 
the new category. 

 

Repeat steps 1 through 16 above to create additional categories. 

 

CREATING COURSE ACTIVITIES 

 

After creating categories in the gradebook, you will be able to assign the proper grade category to each 
activity during set up. When you add graded activities (such as quizzes, assignments, lesson activities, 
etc.) to your course, they are automatically tied to your Moodle gradebook. 

The set up for each activity is different. Some activities are designed to allow grading, and some use 
ratings as a potential grading method. Other activities do not have a built-in grading system, but can be 
graded if desired by adding a manual grade item in the gradebook. 
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CREATING MANUALLY GRADED ITEMS 

 

Graded activities that are not automatically added to the Gradebook can be added manually. Common 
manual grade items could include attendance, projects not using the assignment activity, or a written 
final exam. To manually grade items, use the following steps: 

Step Action Notes 

1.  From the course page, click on the Course 
Management button. Under the User Links 
heading, click Grades overview. 

 

This will open the Grader report. By default, the 
display displays the View tab. Other displays and 
functionality are available via tabs and settings 
on the page. 

2.  On the Grader report page, click the Setup 
tab. 

This will display the Gradebook setup page. 

3.  At the bottom of the page, click the Add 
grade item button. 

This will open a page with settings to add an item 
to the gradebook. 

4.  In the Item name field, type in the name for 
the grade item. 

For example, type “Attendance.” 

5.  Select the desired Grade type from the 
dropdown field. 

For a manually added grade item, there are 4 
grade types available: 

• Value—The grade is a numerical value with 
a minimum and maximum, such as 0-100. 

• Scale—The grade is an item from a list, as 
selected in the Scale field on this page. 

• Text—Feedback is provided, but no grade is 
given. 

Moodle will include value and scale grade types 
in the grade aggregation.  

6.  If you choose the Scale field, select the 
desired scale list. 

This field will only be active if Scale was selected 
for the Grade type. There are five options: 

• Use no scale 
• Separate and Connected ways of knowing 
• Deficiente/Regular/Excelente 
• Default competence scale 
• Unsatisfactory, Satisfactory 

Access the setting for the various scale types by 
clicking the Scales tab. 
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Step Action Notes 

7.  For the Maximum grade field, enter the 
maximum number of points that can be 
given for this graded item. 

This field will only be active if Value was selected 
for the Grade type. 

 

8.  For the Minimum grade field, enter the 
minimum number of points that can be 
given for this graded item. 

This field will only be active if Value was selected 
for the Grade type. 

9.  Click the Hidden checkbox if you want the 
grade for this item to be hidden from the 
student. 

The default is to allow students to view all 
grades. 

You may also add a Hidden until date if you 
would like to release grades only after grading is 
completed. The date fields are accessed by 
clicking the Show more link at the end of the list 
of settings. 

10.  If you want to prevent automatic updating 
by the related activity, click the Locked 
checkbox. 

 

11.  If you want to prevent the weight from 
being automatically adjusted, click the 
Weight adjusted box. 

Checking this box allows you to type a number in 
the Weight field. This figure determines the 
relative value of multiple grade items in a 
category or course. 

12.  Click Save changes. The new item is saved. The display returns to 
Gradebook setup page, where the new item has 
been added to the table of graded items. 

 

ASSIGNING WEIGHTS FOR ITEMS IN WEIGHTED AGGREGATION METHODS 

 

After you have populated the gradebook with categories or grade items, you can assign the desired 
weight for each. 

In the Setup tab in the gradebook, any item that belongs to a category using a weighted aggregation 
method will show a field available under a column called Weight. Enter the weights from your grading 
plan for each of these activities or categories in the gradebook.  
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In this example, the course grade is comprised of only eight grade items. Each item has been assigned a 
particular weight.  

Gradebook Category Weight 
Projects 40 

Participation 20 

Exams 40 
 

NOTE: Weights should total 100 percent.  

 

SUMMARY AND RESOURCES 

 

This tutorial described a basic use of the Moodle gradebook. The gradebook has many other options to 
help you track and award student achievement. As you become familiar with using the gradebook, you 
should explore those options that align with the way you prefer to manage your courses.  

This series includes other guides for using the Moodle gradebook and grading activities. For more 
information, see: 

• Using the Gradebook 
• Advanced Gradebook Options 
• Moodle Activity Grading 

 

VIDEO DEMONSTRATION: 

Watch the following video series to see demonstrations for how to configure the Moodle gradebook. 

• Gradebook (overview): https://youtu.be/bgCeH1DLZ88 
• Part 1, Basic Gradebook: https://youtu.be/4VA_KQPhhmU 
• Part 2, Natural Gradebook: https://youtu.be/COFNomDFEmA 
• Setting up Attendance: https://youtu.be/wB14buUE7Dk 

NOTE: Video demonstrations were not created by Oklahoma CareerTech, and they may use a 
different version of Moodle. However, the steps are the same as the ones you will use. 

 

  

https://youtu.be/bgCeH1DLZ88
https://youtu.be/4VA_KQPhhmU
https://youtu.be/COFNomDFEmA
https://youtu.be/wB14buUE7Dk
https://youtu.be/wB14buUE7Dk
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HOW TO USE THIS TUTORIAL: 

This tutorial can be used as a self-paced lesson or as a lesson plan in a classroom setting. 

• As a self-paced lesson. 

If this is a completely new skill for you, work through the tutorial from beginning to end. 
However, if you have some prior experience with the topic, use the menu hyperlinks on 
page one to jump to a topic that you want to learn. 

Most topics include hyperlinks to video demonstrations. While the videos are useful, you 
don’t have to watch them. All the information that you need is listed in the tutorial text and 
step instructions. 

Follow the steps in the example to practice the skill. This will help to correct any 
misunderstandings or mistakes before you use the skill in your classroom. 

• As a lesson-plan for a classroom. 

When teaching this skill in a classroom, use the tutorial for: 

 Motivation—Use the tutorial introduction as a springboard for a deeper exploration of 
how instructors might use this functionality in their classrooms. Encourage discussion 
and contributions from your students. 

 Demonstration—Once your learners understand the purpose and pedagogical value of 
the functionality, demonstrate the steps of the relevant tasks as listed in the tutorial, 
using your computer and an overhead projector. 

 Practice—Use the tutorial example as a basis for student practice. Assist as necessary. 
 Reference—Encourage learners to use the tutorial post-session as a reference when 

using the functionality. 

 

Return to the tutorial main menu. 

We would appreciate feedback on this tutorial! Please contact the General ctYOU.org Support staff listed 
under Division Contacts on ctYOU.org. 
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